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Advanced Micro Devices is proud to introduce the PALCE16V8, an EECMOS
PAL® device that is pin, function and fuse-map compatible with all 20-pin

GAL® devices. This kit is provided to introduce you to the many benefits of using
electrically erasable, universal architecture PAL devices. Please use the

enclosed business reply card to request additional and more detailed information.

Why do we think you will want to use the PALCE16V8?

Because . . .
+ it replaces up to 16 standard PAL devices,
* it consumes only half the power of those same devices,
+ it is reprogrammable within seconds,
and most importantly . . .
+ itis produced by AMD, the world’s leading supplier of programmable
logic devices.

Give our new PALCE16V8 a try. Take a look at our data sheet and compare the
critical set-up and clock-to-output specifications to other suppliers’ GAL devices.
Once you do, you will agree that the PALCE16V8 is just like a GAL device — only
better! '

@mbﬁé;

Andy Robin
Director of Marketing
Programmable Logic
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PALCE16V8H-15/25

EE CMOS Universal Programmable Array Logic

a1

Advanced
Micro
Devices

DISTINCTIVE CHARACTERISTICS
B Ppin, function and fuse-map compatible with all
20-pin GAL® devices

B Flectrically erasable CMOS technology
provides reconfigurable logic and full
testability

B High speed CMOS technology
— 15-ns propagation delay for “-15” version
— 25-ns propagation delay for “-25” version

B Direct plug-in replacement for the PAL16R8
series and most of the PAL10H8 series

B QOutputs programmable as registered or
combinatorial in any combination

Programmable output polarity

Programmable enable/disable control

n
|
B Preloadable output registers for testability
B Automatic register reset on power up

|

Cost-effective 20-pin plastic DIP and PLCC
packages

Programmable on standard device
programmers

B Supported by PALASM® software

B Fully tested for high programming and
functional yields and high reliability

GENERAL DESCRIPTION

The PALCE16V8is an advanced PAL® device built with
low-power, high-speed, electrically-erasable CMOS
technology. It is functionally compatible with all 20-pin
GAL devices. The macrocells provide a universal device
architecture. The PALCE16V8 will directly replace the
PAL16R8 and PAL10H8 series devices, with the excep-
tion of the PAL16C1.

Device logic is automatically configured accordingto the
user’'s design specification. Design is simplified by
PALASM design software, allowing automatic creation
of a programming file based on Boolean or state equa-
tions. PALASM software also verifies the design and
can provide test vectors for the finished device. Pro-
gramming can be accomplished on standard PAL
device programmers.

The PALCE16V8 utilizes the familiar sum-of-products
(AND/OR) architecture that allows users to implement
complex logic functions easily and efficiently. Multiple
levels of combinatorial logic can always be reduced to
sum-of-products form, taking advantage of the very
wide input gates available in PAL devices. The equa-
tions are programmed into the device through floating-
gate cellsinthe AND logic array that canbe erased elec-
trically.

The fixed OR array allows up to eight data product terms
per output for logic functions. The sumof these products
feeds the output macrocell. Each macrocell can be pro-
grammed as registered or combinatorial with an active-
HIGH or active-LOW output. The output configuration is
determined by two global bits and one local bit control-
ling four multiplexers in each macrocell.
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CONNECTION DIAGRAMS
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ORDERING INFORMATION

Standard Products

AMD/MMI standard products are available in several packages. The order number (Valid Combination) is

formed by a combination of:

a. PROGRAMMABLE

ARRAY LOGIC

a Device Number

b. Speed/Power Option

c. Package Type

d. Operating Conditions

CMOS ELECTRICALLY

ERASABLE

NUMBER OF

ARRAY INPUTS

OUTPUT TYPE:

V = Versatile

NUMBER OF FLIP-FLOPS

b. POWER

H = Half Power

PERFORMANCE

_PAL CE 16 VBHISPC

d. OPERATING CONDITIONS
C = Commercial (0°C to +75°C)

c. PACKAGE TYPE
P = Plastic DIP, (PD 020)
J = Plastic Leaded Chip Carrier,
(PL 020)

-16 =156 nstpp
—25 = 25 ns tpp

Valid Combinations

PALCE16V8H-15

PALCE16V8H-25

PC,JC

Valid Combinations

The valid Combinations table lists configurations
planned to be supported in volume for this device. Con-
sult the local AMD sales office to confirm availability of
specific valid combinations, to check on newly released
combinations, and to obtain additional data on AMD’s
standard military grade products.

PALCE16V8H-15/25



PIN DESCRIPTION

Symbol Type

Function

VCC

GND

CLK/l, TTL input
OE/ls TTL Input
h..le TTL inputs

1/Q,..1/O, TTLI/O

Five Volt Power Input.
Ground
Clock. If the CLK function is not used, it can used as a TTL input signal

Output Enable. If the OE function is not used, it can be used as a
TTL input signal.

Input 1 through Input 8
1/Q, through 1/O;

PALCE16V8H-15/25



FUNCTIONAL DESCRIPTION

The PALCE16V8 is a universal PAL device. It has eight
independently configurable macrocells (MC,.. MC;).
The macrocells can be configured as registered output,
combinatorial output, combinatorial I/O or dedicated in-
put. The programming matrix implements a program-
mable AND logic array, which drives a fixed OR logic ar-
ray. Buffers for device inputs have complementary out-
puts to provide user-programmable input signal polarity.
Pins 1 and 11 serve either as array inputs or as clock
(CLK) and output enable (OE) for all flip-flops.

Unused input pins should be tied directly to VCC or
GND. Product terms with all bits unprogrammed (dis-
connected) assume the logical HIGH state and product
terms with both true and complement of any input signal
connected assume a logical LOW state.

The programmable functions on the PALCE16V8 are
automatically configured from the user’s design specifi-

cation, which can be in a number of formats. The design
specification is processed by development software to
verify the design and create a programming file. This
file, once downloaded to a programmer, configures the
device according to the user’s desired function.

The user is given two design options with the
PALCE16V8. First, it can be programmed as a standard
PAL device from the PAL16R8 and PAL10H8 series.
The PAL programmer manufacturer will supply device
codes for the standard PAL device architectures to be
used with the PALCE16V8. The programmer will pro-
gramthe PALCE16V8 in the corresponding architec-
ture. This allows the user to use existing standard PAL
device files without making any changes to them. This
includes JEDEC files. Alternatively, the device can be
programmed as a PALCE16V8. Here the user must use
the PALCE16V8 device code. This option allows fuil
utilization of the macrocell.
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*In macrocells MC, and MC,, SGH1 is replaced by SGO on the feedback multiplexer.

12015-004A

PALCE16V8 Macrocell
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Configuration Options

Each macrocell can be configured as one of the follow-
ing: registered output, combinatorial output or dedicated
input. In the registered output configuration, the output
bufferis enabled by the OE pin. inthe combinatorial con-
figuration, the buffer is either controlled by a product
term or always enabled. In the dedicated input configu-
ration, it is always disabled. With the exception of MC,
and MC,, a macrocell configured as a dedicated input
derives the input signal from an adjacent 1/0. MC,
derives its input from pin 11(OE) and MC, from pin 1
(CLK).

The macrocell configurations are controlled by bits
stored in the configuration control word. It contains 2
global bits (SG0 and SG1) and 16 local bits (SLOo
through SLO7 and SL1o through SL17). SGO determines
whether registers will be allowed. SG1 determines
whetherthe PALCE16V8 will emulate a 16R8 family or a
PAL10H8 family device. SLOx, in conjunction with SG1,
selects the configuration of the macrocell, and SL1xsets
the output as either active LOW or active HIGH for the
individual macrocell.

The configuration bits work by acting as control inputs
for the multiplexers in the macrocell. There are four mul-
tiplexers: a product term input, an enable select, an out-
put select, and a feedback select multiplexer. SG1 and
SLOx are the control signals for all four multiplexers. In
addition, SLO for the adjacent I/O is a control input to the
feedback multiplexer. In MC, and MC;, SGO replaces
SG1 on the feedback multiplexer. This accommodates
CLK being the adjacent pin for MC, and OE for MCo.

Registered Output Configuration

The control bit settings are SG0 =0, SG1 =1 and SLOx=
0. There is only one registered configuration. All eight
product terms are available as inputs to the OR gate.
Data polarity is determined by SL1x The flip-flop is
loaded onthe LOW to HIGH transition of CLK. The feed-
back path is fromQ on the register. The output buffer is
enabled by OE.

Combinatorial Configurations

The PALCE16V8 has three combinatorial output con-
figurations: dedicated output in a non-registered device,
1/0 in a non-registered device and I/0 in a registered de-
vice.

Dedicated Output In a Non-Registered-
Device

The control bit settings are SG0 =1, SG1 =0 and SLOx =
0. All eight product terms are available to the OR gate.
Because the macrocell is a dedicated output, the feed-
back is not used. Because CLK andOE are notusedina
non-registered device, pins 1 and 11 are available as in-
put signals. Pin 1 will use the feedback path of MC; and
pin 11 will use the feedback path of MC,.

Combinatorial /0 In a Non-Registered
Device

The control settingsare SGO=1,SG1=1,and SLOx=1.
Only seven product terms are available to the OR gate.
The eighth product term is used to enable the output
buffer. The signal at the 1/O pin is fed back to the AND
array via the feedback multiplexer. This allows the pinto
be used as an input.

Because CLK and OE are not used in a non-registered
device, pins 1 and 11 are available as inputs. Pin 1 will
use the feedback path of MC;and pin 11 will use the
feedback path of MC,.

Combinatorial I/O in a Registered Device

The control bit settings are SG0 = 0, SG1=1and SLOx =
1. Only seven product terms are available to the OR
gate. The eighth product term is used as the output
enable. The feedback signal is the corresponding I/0
signal.

Dedicated Input Configuration

The control bit settings are SG0 =1, SG1=0and SLOx =
1. The output bufferis disabled. Except for MC, and MC,
the feedback signalis an adjacent I/0O. For MC, and MC,
the feedback signals are pins 1 and 11. These configu-
rations are summarized in Table 1 and illustrated in Fig-
ure 2.

Macrocell Configuration

SGOI SG1I SLOxl Cell Configuration| Devices Emulated

Device Uses Registers

Registered Output | PAL 16R8, 16R6,
16R4

Combinatorial I/0 | PAL16R6, 16R4

Device Uses No Registers

1 0 0 PAL10H8, 12Hs,
14H4, 16H2, 10L8,
1216, 14L4, 1612
PAL12H8, 14H4,
16H2, 1216, 14L4,
16L2

PAL16L8

Combinatorial
Output

1 0 1 | Input

1 1 1 | Combinatorial /O

Programmable Output Polarity

The polarity of each macrocell can be active HIGH or
active LOW, either to match output signal needs or to
reduce product terms. Programmable polarity allows
Boolean expressions to be written in their most compact
form (true or inverted), and the output can still be of the
desired polarity. it can also save “DeMorganizing”
efforts.

Selection is through a programmable bit SL1x which
controls an exclusive-OR Gate at the output of the AND/
OR logic. The output is active-HIGH if SL1x is “1” and
active-LOW if SL1x is “0”.

PALCE16V8H-15/25 vii
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Figure 2. Macrocell Configurations
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Power-Up Reset

Aliflip-flops power up to a logic LOW for predictable sys-
tem initialization. Outputs of the PALCE16V8 will de-
pend onwhetherthey are selected as registered or com-
binatorial. If registered is selected, the output will be
LOW. If combinatorial is selected, the output is a func-
tion of the logic.

Electronic Signature Word

An electronic signature word is provided in the
PALCE16V8 device. It consists of 64 bits of programm-
able memory that can contain user-defined data. The
signature data is always available to the user independ-
ent of the security bit.

Programming and Erasing

The PALCE16V8 can be programmed on standard logic
programmers. Approved programmers are listed in this
data sheet.

The PALCE16V8 may be erased to reset a previously
configured device back to its virgin state. Bulk erase is
automatically performed by the programming hardware.
No special erase operation is required.

Security Bit

A security bit is provided on the PALCE16V8 as a deter-
rent to unauthorized copying of the array configuration
patterns. Once programmed, this bit defeats readback
of the programmed pattern by a device programmer, se-
curing proprietary designs from competitors. However,
programming and verification are also defeated by the
security bit. The bit can only be erased in conjunction
with the array during a bulk erase cycle.

Basic PAL Device Notation

The multi-input gates inthe PAL device's programmable
AND gate array are simplified in the logic diagrams. The
PAL device notation for an AND gate, called a product
termin a PAL device, is shown below.

[ ) A*D

12015-006A

Figure 3. PAL Device AND Gate

This is equivalent to the standard logic notation below.

A

12015-007A

Figure 4. Standard AND Gate

Each vertical line inthe PAL device is a potential input to
the AND gate. At each crosspoint is a programmable
bit, which provides a potential connection in the pro-
grammed state. The Xs in the diagram indicate a con-
nection at the crosspoint.

In electrically erasable devices the crosspoints are origi-
nally disconnected. They are either connected or left
open during device programming.

Multiplexers in the PAL device logic diagrams use a sim-
ple notation for maximum clarity. A 2:1 multiplexer that
selects X when the control is LOW and Y when the
control is HIGH is shown below.

Y1 1 Y11

Z=X Z=Y

" 12015-008A

Figure 5. PAL Device Multiplexer

Notice that the control is operated by a programmable
cell that is initially disconnected from GND, floating to
Vee, selecting the “1” path through the multiplexer.
When the cell is programmed, it is connected to GND
selecting the “0” path through the multiplexer.

PALCE16V8H-15/25 ix
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ABSOLUTE MAXIMUM RATINGS OPERATING RANGES

Storage Temperature —65°C to +150°C Commercial (C) Devices
Ambient Temperature under bias  -55°C to +125°C Temperature (T.) Operating
Supply Voltage with Respect Free Air 0°C to +75°C
to Ground —-0.5V to +7.0V Supply Voltage (Vec) +4.75V to +5.25V
DC Output Voitage _0055\)/ 10 Veet Operating ranges define those limits between which the func-
DC Input Voltage —0.5V 1o Voot tionality of the device is guaranteed.
0.5V
Static Discharge Voltage >2001V

Latchup Current (TA = 0°C to 75°C) >100mA

Stresses above those listed under ABSOLUTE MAXIMUM
RATINGS may cause permanent device failure. Functionality
at or above these limits is not implied. Exposure to absolute
maximum ratings for extended periods may affect device

reliability.
DC CHARACTERISTICS over operating range unless otherwise specified.
Parameter Parameter
Symbol Descriptions Test Conditions Min. Max. | Unit
Vou Output HIGH Voltage Vee = MIN low = —3.2 MA 2.4 v
Vin=VworV,
Voo Output LOW Voltage Vee = MIN loL = 24mA 05 \"
Vin=VworVy
Vi Input HIGH Voltage Guaranteed Input Logical HIGH 2.0 \)
Voitage for all Inputs (Note 1)
Vi Input LOW Voltage Guaranteed Input Logical LOW 0.8 Vv
Voltage for all Inputs (Note 1)
I Input Leakage Current GND <V, <V, Max. (Note 2) 10 HA
I -10
lozy Off-State Output Current GND 2V, 2V, Max. (Note 2) 10 HA
lozi -10
los Output Short-Circuit Current Vee = Max. Vour = 0V (Note 2) -30 -130 mA
lecc Supply Current Outputs Open (lo = 0A) 90 mA
Vee = Max., F = 15MHz i

Notes:

1. These are absolute values with respect to device ground and all overshoots due to system or tester noise are included.
2. 1/O pin leakage is the worst case of I, and loz (or I and lozw).
3. No more than one output should be shorted at a time and duration of the short-circuit should not exceed one second.

Capacitance (Note 1)

Parameter Parameter

Symbol Descriptions Test Conditions Typ. | Unit
Cuw Input Capacitance Vee = 5.0V, Ta = +25°C 5 pF
Cour Output Capacitance Vi =2.0V atf=1MHz 15 pF

Note:

1. These parameters are not 100% tested, but are evaluated at initial characterization and at any time the design is modi-
fied where capacitance may be affected.

Xii PALCE16V8H-15/25



SWITCHING CHARACTERISTICS over Commercial operating range (Note 1)

Parameter | Parameter =15 -25
Symbol Description Min. | Max. | Min. Max. | Unit
teo Input or Feedback to Combinatorial Output (Note 2) 15 25 ns
ts Setup Time from Input or Feedback to Clock 12 15 ns
tu Hold Time ns
teo Clock to Output 10 12 ns
ter Clock to Feedback 10 ns
tw Width of Clock LOW 8 10 ns
twn HIGH 8 10
Maximum External Feedback 1/(ts+tco) 455 37
fuax Frequency Internal Feedback 1/(ts+tcr) 50.0 40 MHz
(Note 3) No Feedback 1/(twr+wt) 62.5 40
tezx OE to Output Enable (Note 4) 15 20 ns
toxz OE to Output Disable (Note 4) 15 20 ns
tea Input to Output Enable (Notes 4 and 5) 15 25 ns
ter Input to Output Disable (Notes 4 and 5) 15 25 ns
Notes:

1. Commercial Test Conditions: R, = 200Q, R, = 390Q (see switching test circuit).
2. tep is tested with S, closed and C, = 50pF (including jig capacitance). Vi = 3V, ViL = OV, Vou = Vo = 1.5V.
3. These parameters are not 100% tested, but are calculated at initial characterization and at any time the design is modified

where frequency may be affected.
4. For three-state outputs, enable times are tested with C_ = 50pF to the 1.5V level; S, is open for high-impedance to HIGH

tests and closed for high-impedance to LOW tests. Output disable times are tested with C, = 5pF. HIGH to high-

impedance tests are made to an output voltage of Vou —0.5V with S, open; LOW to high-impedance tests are made to an
output voltage of Vg to +0.5V with S, closed.
5. Equivalent function o tez, texz but using product term control.

PALCE16V8H-15/25
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SWITCHING WAVEFORMS

Input or (A
Feedback
tep
Combinatorial v
T
Output
12015-010A
Combinatorial Output
Clock Vr
Combinatorial '0' XD '0'0'0‘ '0"’ V.
OUtpUt A’A’A’A .A’A’A ‘ T

12015-019A

Clock to Feedback to Combinatorial Output
(See Path at Right)

twn—>
Clock ' \_f
twi
12015-011A
Clock Width
Input or Vy
Feedback
tg—> ty
7£ Vr
Clock < teo
Registered Vr
Output

12015-012A
Registered Output

Notes:

1. Vs =15V

2. Input pulse amplitude 0 Vo 3.0 V

3. Input rise and fall times 2 — 5 ns typical

Register B
Logic
'pD -
tcF
12015-020A
Input >E/T
tep® t
outout Vo~ 0.5V s
uipu 2 VoLt 05V
12015-013A

Input to Output Disable/Enable

OF VT
tpxz tpzx
Von-0.5V e
12015-014A
OE to Output Disable/Enable
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SWITCHING TEST CIRCUIT

Vee o0—0"
Ry
Output O I
R
2
I"
Switching Test Circuit
12015-019A
Notes on Testing Information
Specification Switch S CL R: R2 Measured Output Value
teo, teo, tor Closed 50 pF 200 Q 390 Q 1.5V
thx, tea Z->H: Open
Z->L: Closed 50 pF 200 Q 390 Q 1.5V
texz, ten H->Z: Open H->Z: Vou —0.5V
L>Z:Closed | °0PF | 200Q | 3%0Q L->Z: Vou +0.5V
Key to Switching Waveforms
WAVEFORM  INPUTS OUTPUTS
MUST BE WILL BE
e STEADY STEADY
WILL BE
MAY CHANGE
CHANGING
m_ FROMHTOL  Zooes T
MAY CHANGE ~ WILL BE
CHANGING
M DONTCARE,  CHANGING,
ANY CHANGE ~ STATE
PERMITTED UNKNOWN

12015A-018A
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Apply the desired value (Viv/Vi) to all registered out-

Output Register Preload
put pins. Leave combinatorial output pins floating.

The PRELOAD function allows the registers to be

. - : : 5. Clock pin 1 from Vi to Vim.
loaded from the output pins. This feature aids functional .
testing of sequential designs by allowing direct setting of g E‘emovg V'LN'“V"O\T all registered outputs.
output states. The procedure is as follows. - Lowerpin 8 to Vu/Vi. o
8. Enable the output registers by lowering OE.
1. Raise Vecto 5.0V +05V. 9. Verify for Vou/Von at all registered output pins. Note
2. Setpin81t010.0V+05V. that the output pin signal will be the inverse of the
3. SetOE HIGH. preload input.
Parameter
Symbol Parameter Description Min. Rec. Max. | Unit
tro Setup and Hold Time from Preload (pin 8) to OE 50 50 us
tes Setup Time from OE to Data 1 1 us
ton Hold Time from Data to OE 1 1 us
tecs Setup Time from Data to Clock 1 1 us
ten Hold Time from Clock to Data 1 1 us
dVy/dt Vewo Rising Slew Rate (pin 8) 10 100 | Vius
dVy/dt Vewo Falling Slew Rate (pin 8) 2 3 Vius
Voo — — — —
Pin 8 t tolo
PLD
——————— Vin

=]

Clock

12015-015A

Preload Waveforms

XVi PALCE16V8H-15/25



Power-Up Reset

The PALCE16V8 has been designed with the capability
to reset during system power-up. Following power-up,
all flip-flops willbe reset to LOW. The output state will be
HIGH independent of the logic polarity. This feature pro-
vides extra flexibility to the designer and is especially
valuable in simplifying state machine initialization. A
timing diagram and parameter table are shown below.

Due to the synchronous operation of the power-up reset
and the wide range of ways Vcc can rise to its steady
state, two conditions are required to insure a valid
power-up reset. These conditions are:

1. The Vcc rise must be monotonic.

2. Following reset, the clock input must not be driven
from LOW to HIGH until all applicable input and feed-
back setup times are met.

Parameter Parameter
Symbol Descriptions Min. Max. Unit
ter Power-Up Reset Time 100 us
ts Input or Feedback Setup Time o .
See Switching Characteristics
tw Clock width
Vee
Power 4V
PR > |
Registered
Active LOW /
Output tS >
Clock \%
tw —>|
12015-017A
PALCE16V8H-15/25 xvii



fuax Parameters

The parameter fmax is the maximum clock rate at which
the device is guaranteed to operate. Because flexibility
inherent in programmable logic devices offers a choice
of clocked flip-flop designs, fuax is specified for three
types of synchronous designs.

The first type of design is a state machine with feedback
. signals sent off-chip. This external feedback could go
back to the device inputs, or to a second device in a
multi-chip state machine. The slowest path defining the
period is the sum of the clock-to-output time and the
input setup time for the external signals (ts + tco). The
reciprocal, fuax, is the maximum frequency with external
feedback or in conjunction with an equivalent speed
device. This fmax is designated “fwax external.”

The second type of design is a single-chip state ma-
chine with internal feedback only. In this case, flip-flop
outputs are defined by the device inputs and flip-flop
outputs. Under these conditions, the period is limited by
the internal delay from the flip-flop outputs through the
internal feedback and logic to the flip-flop inputs (ts +
ter). This fMAX is designated “fwax internal”.

The third type of design is a simple data path applica-
tion. In this case, input data is presented to the flip-flop
and clocked through; no feedback is employed. Under
these conditions, the period is limited by the sum of the
data setup time and the data hold time (ts +t+). However,
as lower limit for the period of each fmax type is the mini-
mum clock period (tw+ + tw). Usually, this minimum
clock period designates the period for the third fwax, des-
ignated “fwax no feedback”.

CLK
[ e e e e e e e e e e e ] e e e e e 1
| |
| Y !
i R
| |
[ -T’ LOGIC jmuumipi REGISTER I
| |
L e e J

CLK
r———————————m————— ]
| |
| v |
S S .
| LOGIC || REGISTER {
[ [
| l |
| -l |
e e e e e e e e e — —  —— ——————— o

fmex Internal Feedback; 1/(ts + tce)

CLK
r—————————————1] )
| 1
| Y |
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PALASM 2 SOFTWARE
SUPPORT FOR THE
PALCE16V8

About this Section

This section describes PALASM 2 software special considerations for the
PALCE16V8. It is intended as a supplement to the PALASM 2 software user
documentation in part 4 of the 1988 PAL Device-Data Book. -If you -do-not
already have the Data Book, contactyour-local AMD sales office for a.copy.

Boolean Equation Designh Entry
1. The pin list for the PALCE16VS8 follows.

;1 2 3 4 5 6 7 8 9 10
CLK I2 I3 I4 15 16 I7 18 I9 GND

;11 12 13 14 15 16 17 18 19 20
OE 01 02 03 04 05 06 07 08 vCccC

Note: The lines beginning with a semicolon (;) are comments and are
ignored by the software.

2. Youuse the SIGNATURE command to program the signature fuse. The
command must be used in the Declaration segment of your design file.
It must follow the CHIP statement. If you enter it in the Equations
segment, the software displays an error message.

The signature command syntax follows.
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Syntax
SIGNATURE = number
or
string
Each of the syntax options is defined below.
Syntax option 1:

SIGNATURE = number

The number you use can be

* binary #B or #b
« octal #0O or #o
* decimal #D or #d
* hexadecimal #H or #h

Notice that each number base is specified by an upper case-or lower
case designator. The examples below illustrate different ways to
specify the signature as a number.

Examples

SIGNATURE 123456

SIGNATURE = #D845

SIGNATURE #H 1976A5

Note the following

* The space in the last example is allowed, but is deleted by the
software.

*  Number designators are optional. If you do not use a number
designator, the software assumes a decimal number.
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Simulation

¢ The 64 least significant bits are programmed. The remaining most
significant bits on the left are truncated.

*  The software does not program decimal numbers greater than 15
digits.

Syntax option 2:

SIGNATURE

string
Examples
SIGNATURE = abcdefgh

SIGNATURE

ABC_123

Note the following.

* A string must begin with an alpha character.

*  Alphanumeric characters and underscores are allowed.

¢ The software converts alpha characters to the corresponding
ASCII code.

¢ Spaces are allowed in strings.

* The software converts all lower case characters that you enter into
upper case characters.

¢ The left-most 8 characters are programmed with the corresponding
ASCll.code. The remaining characters on the right are truncated.

The PRELOAD command replaces the old PRLDF command described in
Chapter 4 of the PAL Data Book.

Include the PRELOAD command in the simulation segment of your PDS
design file. The syntax for the PRELOAD command follows.
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Syntax

PRELOAD list of register identifiers
Example

PRELOAD 01 /02 03

The example above shows the PRELOAD command setting the register
values to 101 (high, low, high).

The PRELOAD command is similar to the old PRLDF command. It forces a
register into a known state, either 1 or 0. The PRELOAD statement allows
you to initialize registers.

Figure 1 illustrates a PALCE16V8 output register. Notice the register is
identified by the output node name A.

Figure 1: Output Register

To set the A register value to 1, the PRELOAD statement is written as shown
in the example below.

Example

PRELOAD A

In the example above, the PRELOAD command sets the register to a value
of 1. The inverter causes the output value to change to 0. Thus, the

PRELOAD command determines the value of the register alone. The output
value is determined by the device architecture.

a-4
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Note: Unlike the PRELOAD command, the old PRLDF command determined
the value of outputs not registers.

The example below shows a partial simulation segment for a PALCE16V8.
Example

CHECK 014 /015 016 /017
SETF OE

PRELOAD /014 /015 016 017 ;Preload registers=0010

SETF /OE ;Check output
CHECK 014 015 /016 017

CLOCK CLK ;Next state
CHECK 014 /015 0Ol6 /017

Note: The above example assumes the pin list shown earlier in this
document.

Keep the following special considerations in mind when using the PRELOAD
command on the PALCE16V8.

*  The register is forced to a known state and the output is calculated from
the register.

«  After the register is clocked, the value that represents the next state
appears at the output.

*  An error is generated if the output is not disabled before preload.

* The PRELOAD statement works on the register; the CHECK statement
validates the output.
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About this Tutorial

About this Tutorial

This tutorial is a step-by-step procedure on using PALASM software to
design a decoder for the PALCE16V8. It describes only those features of
PALASM software that are required for the decoder design. Therefore, it
works merely as an introduction to PALASM software. The full featured
version of the software provides you with additional design capability for
advanced applications. Contact your local Advanced Micro Devices sales
office for a full-featured version of PALASM software. The software
package includes a comprehensive user manual.

Prerequisites

* Youneed an IBM-PC/XT/AT or compatible with
a hard disk.

*  You need the two software' disks labelled
PALCE16VS8 Evaluation Kit.

¢ To program the PALCE16V8 sample, a
programmer must be linked up to your computer.

+ To communicate with the programmer, a
programmer communications program of your
choice must be installed on your computer.

How to Use this Tutorial

This tutorial is designed to be read sequentially from beginning to end.
First you install the software, then create a Boolean equation design,
compile the design, simulate the design, and finally view the output files.
The process takes approximately one hour.
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Install the Software

Install the Software

The software on the two floppy disks labelled PALCE16V8 Evaluation Kit
has been compressed into archive format. The installation procedure
dearchives the software programs before installing them on your hard disk.
This procedure takes approximately seven minutes.

Step 1.

Step 2.

Step 3.

Step 4.

Step 5.

Place disk #1 in drive A.
Enter A: INSTALL <return>

At the prompt, specify the drive on which you want
the software installed.

At the prompt, if necessary, allow the software to
make changes to the system files AUTOEXEC.BAT
and CONFIG.SYS.

When the message window at the bottom of your
screen prompts you, place disk #2 in drive A.

When the installation procedure is complete, the
following message appears on your screen.

Re-boot and enter C: PALC16VS8

Follow the instructions to start up the program.

Note

The command to call up the software is PALC16VS8 and not PALCE16VS.

March 1989
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Learn the Menu

Learn the Menu

The PALCE16V8 Evaluation Kit banner is the first screen that appears
when you call up the software. When you press any key, the menu appears
on your screen.

Figure 1 shows the four part software menu. These four parts, File, Edit,
View and Run are arranged at the top of the screen in a menu bar.

Figure 1. PALASM Menu Screen

Menu bar Status line
File menu PAL Setup

etrieve Degign -
Change Directory
Setup
Goto SysterJ
Quit

| PAL Setup

C:PALC16V8
: DECODER
- Device Name: PALCE16V8
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Learn the Menu

Each of the menu bar items contains a different set of program options
related to that menu function. For example, the options for finding a file or
a directory are located in the File menu. When you highlight one menu bar
item, its menu appears. Notice that you can move laterally across the screen
using the cursor movement arrows.

The status line at the bottom of the screen gives information about how to
control the screen. Check this information frequently because the
information changes as you perform different tasks. Use the arrow keys to
move the cursor to the operation you wish to perform.

Get familiar with the menu by exploring the various options. When you are

ready to begin using the software functions, proceed to Create the Decoder
Design.

March 1989 Design a Decoder for the PALCE16V8 5



Create the Decoder Design

Create the Decoder Design

The simple decoder design is created in Boolean equations and implemented
in a PALCE16V8 device. Your first task in creating the design is to
understand the function of the decoder and interpret the function in Boolean
equations.

Note
Although decoders are usually combinatorial, for the purpose of this
exercise assume a registered decoder design.

The Function of the Decoder

Table 1 shows a truth table for the decoder. The decoder has three input
pins: X, Y, and Z. The function of the decoder is to monitor the three input
pins and assert one of eight output lines, A-H, for each of the eight
combinations of inputs.

Table 1. Truth Table for Decoder

Inputs Outputs Generated

XY Z A BCDETFGH
000 1 00 00O0O0O
0 0 1 0100O0O0O00O0
010 001 0O0O0O0TO 0
011 0001 0O0O0O0 0
1 00 000O0T1O0O0TO0
1 01 0 00 0O0OT1O0TO0
1 10 000O0OO0OT10O0
1 11 000 O0O0OO0OO0OT1
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Create the Decoder Design

Notice that each of the output pins is high, or has a value of 1, in response
to a unique combination of the three input pins. Output pin A, for example,
is high only if the three input pins are low. The Boolean expression that
corresponds to this condition is

X*[Y*/Z

Note
* is used for AND
/ is used for NOT

You can create a Boolean equation that defines all the conditions under
which output pin A is high:

A=X*[Y*[Z

Similarly, you can create all of the Boolean equations required to completely
define the decoder functions:

A=/X*[Y*/Z
B=/X*/Y*Z
C=/X*Y*/Z
D=/X*Y*Z
E=X*/Y*/Z
F=X*/Y*Z
G=X*Y*/Z
H=X*Y*Z

Now that you have Boolean equations to describe the decoder functions, it
is time to create a complete PALASM design file for the decoder.
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Learn the Structure of the PALASM Design File

PALASM software requires a specific design file layout. Figure 2
illustrates the layout. The equations defined above go into the Equations
segment of the file.

Figure 2. PALASM Design File Layout

DECLARATION SEGMENT

EQUATIONS SEGMENT

SIMULATION SEGMENT

The PALASM design file is also known as the PDS (PAL device Design
Specification) file.

Proceed to Build the Declaration Segment to begin creating the decoder
design file using PALASM software.

Build the Declaration Segment

The PALASM software menu provides a template for building the
Declaration segment of your design file. The procedure to use the template

follows.

Step 1. Use your arrow keys to move to the File menu..
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Create the Decoder Design

Step 2. Select New Design File in the File menu and press
<return>.

Step 3. A window appears. Enter a file name of your
choice. This tutorial uses the file name shown
below.

Enter DECODER.PDS <return>

The PDS Declaration Segment template appears-on
your screen.

Figure 3 shows the template as it appears on your screen. Notice you can
use <return> to move from field to field. However, some fields require you
to enter information before you can move on. Also, use F10 and not
<return> to save the segment.
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Create the Decoder Design

Figure 3. Screen Template of PDS Declaration Segment

Enter the File Header Information

The first part of the Declaration segment consists of descriptive information
about your file. You can enter the following or similar information for the
decoder design.  Figure 4 shows the completed file header.
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Create the Decoder Design

Figure 4. File Header for the Decoder Design

TITLE DECODER

PATTERN A

REVISION 1.0

AUTHOR J. ENGINEER

COMPANY ADVANCED MICRO DEVICES
DATE 3/20/89

Enter the CHIP Statement

The chip name and the device name are required fields. You can enter a
descriptive chip name of your choice. The software selects the device
name, PALCE16V8, for you.

CHIP ChipName = PAL_AMD Device PALCE16V8

Enter the Pin List

Each pin on the PALCE16VS8 that you use in your design requires a pin
statement. The pin statement consists of the following fields.

e Pin
e Pin number
* Pinname

« Input, output, or I/O
Specify one of the above.

« Input or Output type

Specify whether the input or output is
combinatorial or registered.
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Create the Decoder Design

+ Polarity type
Specify whether the output is active-low or
active-high.

In Create the Decoder Design notice that the decoder design consists of three
inputs and eight outputs. In addition, you must define pin 1 as the-clock pin
and pin 11 as the output enable pin.

The procedure to enter the pin list follows.

Step 1. Enter the pin statements using the arrow keys or the
tab key to move from field to field. Notice that the
template allows you to save time by giving you
choices for several of the fields
Figure 5 shows the completed pin list.

Step 2. Press F10, not <return>, to save your pin list-and
exit the template
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Figure 5. Pin List for the Decoder Design

Pin Number Name I/0 Type Polarity

Pin 1 CLOCK Input Comb Active-high
Pin 2 X Input Comb Active-high
Pin 3 Y Input Comb Active-high
Pin 4 Z Input Comb Active-high
Pin 11 OE Input Comb Active-high
Pin 12 A Output Reg Active-high
Pin 13 B Output Reg Active-high
Pin 14 C Output Reg Active-high
Pin 15 D Output Reg Active-high
Pin 16 E Output Reg Active-high
Pin 17 F Output Reg Active-high
Pin 18 G Output Reg Active-high
Pin 19 H Output Reg Active-high

PALASM software transfers you to the editor and displays the file
DECODER.PDS. Notice that the entire Declaration segment that you
created in the template has been copied into the file. Also notice that
headings of the remaining segments of the file have been entered to prompt
you to complete the design file:

The Equations Segment
The Simulation Segment

Proceed to Build the Equations Segment to complete the next part of the
decoder design file.
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Create the Decoder Design

Build the Equations Segment

The Equations segment contains the Boolean equations that specify the
decoder design.

In Table 1, the truth table defines the desired outputs A-H as a function of
the inputs X, Y, and Z.

Figure 6 shows the complete equations segment for the decoder design file

Figure 6. Equations Segment for the Decoder Design

EQUATIONS

A=/X* /Y */Z
B=/X* /Y * %
C=/X* Y * /2
D=/X* Y*x 2
E= X*x /Y * /%
F= X*x/Y* 2
G= X* Y * /2
H= X* Y * 2

After exiting the PDS Declaration Segment template, the software displays
the file DECODER.PDS on your screen. You are now in the editor. Until
you quit the editor and return to PALASM, use the editor commands. The
procedure to enter the Boolean equations in the Equations segment of the
DECODER.PDS file follows.

Step 1. Use the arrow key to move the cursor to the line just
under the keyword EQUATIONS.
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Step 2. Enter the Boolean equations as shown in Figure 6.
At the end of each line, press <return> to go to the
next line.

Step 3. When you have entered all the equations, press
<escape> to display the menu bar.

Step 4. Go to the File menu, and select Save.

Proceed to Build the Simulation Segment to complete the decoder design
file.

Build the Simulation Segment

This segment of the design file is optional. Including the simulation
segment in the design file makes simulation of the design possible.
Simulation allows you to predict the behavior of your design in software.
The PALASM simulator allows you to monitor the status of inputs and
outputs, to control the input signals, and to check the outputs against your
predicted outputs.

To simulate this design thoroughly, you must

» Set the inputs in every possible combination.

« Check if each combination of inputs produces the
desired outputs.

«  Supply a clock pulse to effect the change in
outputs.
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» Enable the outputs by setting the output-enable
(OE) pin low.

The simulation for the decoder design may be described in natural language
as follows.

Set the output enable, clock, and input levels to /OE /CLOCK /X /Y /Z.
Supply a clock pulse.

Check that the output levels are A /B /C /D /E /F /G /H.
Set the input levels to /X /Y Z.

Supply a-clock pulse.

Check that the output levels are /A B /C /D /E /F /G /H.
Set the input levels to /X Y /Z.

Supply a clock pulse.

Check if the output levels are /A /B C /D /E /F /G /H.
Set the input levels to /X Y Z.

Supply a clock pulse.

Check if the output levels are /A /B /CD /E /F /G /H.
Set the input levels to X /Y /Z.

Supply a clock pulse.

Check if the output levels are /A /B /C /D E /F /G /H.
Set the input levels to X /Y Z.

Supply a clock pulse.

Check if the output levels are /A /B /C /D /E F /G /H.
Set the input levels to X Y /Z.

Supply a clock pulse.

Check if the output levels are /A /B /C /D /E /F G./H.
Set the input levels to X Y Z.

Supply a clock pulse.

Check if the output levels are /A /B /C /D /E /F /G H.

PALASM uses simple commands to define the simulation instructions.
Figure 7 shows the completed simulation segment for the decoder design in
PALASM syntax.
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Figure 7. Simulation Segment for the Decoder Design.

SIMULATION

SETF /OE /CLOCK /X /Y /Z
CLOCKF CLOCK

CHECK A /B /C /D /E /F /G /H
SETF /X /Y Z

CLOCKF CLOCK

CHECK /A B /C /D /E /F /G /H
SETF /X Y /2

CLOCKF CLOCK

CHECK /A /B C /D /E /F /G /H
SETF /X Y 2Z

CLOCKF CLOCK

CHECK /A /B /CD /E /F /G /H
SETF X /Y /2

CLOCKF CLOCK

CHECK /A /B /C /D E /F /G /H
SETF X /Y 2

CLOCKF CLOCK

CHECK /A /B /C /D /EF /G /H
SETF XY /z

CLOCKF CLOCK

CHECK /A /B /C /D /E /F G /H
SETF XY Z

CLOCKF CLOCK

CHECK /A /B /C /D /E /F /G H

The procedure to enter the Simulation commands in the DECODER.PDS
file follows.
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Step 1.

Step 2.

Step 3.

Step 4.

Step 5.

Step 6.

Step 6.

In the editor file, DECODER.PDS, use the arrow
key to move the cursor just under the keyword
SIMULATION.

Enter the Simulation segment shown in Figure 7. At
the end of each line, press <return> to go to the next
line.

When you have entered all the equations, press
<escape> to display the menu bar.

Go to the File menu, and select Save.

Figure 8 shows you the complete decoder-design
file. Check your editor file to see if there are any
typos. Your file will not-process correctly if there
are syntax errors. Correct your errors and save the
file again.

Press <esc> to call up the editor menu bar.

Select Quit All Files in the Quit menu to return to
PALASM.

The decoder design file is now complete and ready for PALASM to '
process. Proceed to Process the Design File .
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Figure 8 Complete Decoder Design File

;PALASM Design Description

TITLE
PATTERN
REVISION
AUTHOR
COMPANY

DATE

CHIP

March 1989

3/20/89
PAL_AMD
CLK
X
Y
z
OE
A HIGH
B HIGH
C HIGH
D HIGH
E HIGH
F HIGH
G HIGH
H HIGH

DECODER.PDS
A
1.0
J. ENGINEER

ADVANCED MICRO DEVICES, INC.

REG
REG
REG
REG
REG
REG
REG

REG

PALCE16V8
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O Boolean Equations Segment .
EQUATIONS

A= /X * /X * /Z

B=/X* /Y * Z

C=/X* Y * /7

D=/X* Y * Z

E= X * /Y * /Z

F= X* /Y * Z

G= X* Y *x /7

H= X * Y * 7
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SIMULATION

SETF /OE /CLOCK /X /Y /Z
CLOCKF CLOCK

CHECK A /B /C /D /E /F /G /H
SETF /X /Y 2

CLOCKF CLOCK

CHECK /A B /C /D /E /F /G /H
SETF /X Y /%2

CLOCKF CLOCK

CHECK /A /B C /D /E /F /G /H
SETF /X Y Z

CLOCKF CLOCK

CHECK /a /B /CD /E /F /G /H
SETF X /Y /2

CLOCKF - CLOCK

CHECK /A /B /C /DE /F /G /H
SETF X /Y 2

CLOCKF CLOCK

CHECK /A /B /C /D /EF /G /H
SETF XY /2

CLOCKF CLOCK

CHECK /A /B /C /D /E /F G /H
SETF XY 2

CLOCKF CLOCK

CHECK /A /B /C /D /E /F /G H
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Process the Design File

Before you begin processing the decoder design created in the previous
sections, take a look at the software processing sequence.

The processing sequence consists of two simple steps.
1. Compile the design and generate JEDEC output.
2. Simulate the design.
The main purpose of using PALASM is to translate your input-design into
programmer-readable JEDEC output. However, through simulation,
PALASM allows you to test your design without actually programming a

device.

Figure 8 illustrates the software processing sequence. Notice that both the
compile and Simulation processes generate output files.

Figure 9. PALASM Software Processing Sequence

P ]

Compile Simulate
the Design {  the Design
Fuse Map —— Simulation History
JEDEC Fuse Data  }—— Simulation Trace
|___ JEDEC Test Data
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Now that you have an overview of the procedure, you can begin processing
the decoder design. Proceed to Autorun Compile and Simulate.
Autorun Compile and Simulate

Use the arrow keys to go to the Run menu in PALASM. Notice that the
Run menu offers you three choices. Figure 9 illustrates the Run menu.

Figure 10. Run Menu

{ le
Simulate
Autorun

Ct an option <homestop of line

PALASM software offers you a time saving autorun feature that combines
the compile and Simulation processes into one keystroke. The autorun
procedure follows.

Step 1. Select Autorun in the Run menu
A window opens at the bottom of your screen.
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Step 2. Watch the status line as PALASM software
completes the following operations.

Parse
Assemble

Simulate

Step 3. When you see the message

PLDSIM Program Successful
Press <esc>.

If the process was successful, you can skip steps 4-
11.

If the process was unsuccessful and produces-errors,
proceed to step 4.

Step 4. Select Edit in the PALASM menu bar. The Edit
menu appears on your screen.

Step 5. Select Design File in the Edit menu. The design file
DECODER.PDS appears.
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Step 6.

Step 7.

Step 8.

Step 9.

Step 10.

Step 11.

Step 12.

Create the Decoder Design

Carefully compare the file on your screen with the
printed file in Figure 8, Complete Decoder Design
File. If your have typos in your screen file, make the
necessary changes.

Press <esc> to display the editor menu bar.

Select File in the menu bar. The File menu appears.

Select Save in the File menu.

To quit the editor, select Quit in the menu bar. The
Quit menu appears.

Select Quit All Files. The software returns you to the
PALASM menu.

Now repeat steps 1-3 to recompile and simulate your
design file.

Note

The decoder design has been tested and found error-free. If your compile
and simulation processes produce errors, you probably have typos in your

file.

Now that the design file has been successfully processed, you can look at
the output files that the compile and simulation processes generated.
Proceed to View the Output Files.
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View the Output Files

In the last section you used autorun to run the compile and Simulation
processes with one keystroke. PALASM, however, generates a set of
output files after each process. Proceed to view each set of output files.

The procedure to view any of the output files follows.
Step 1. Use the arrow keys to select the View menu.

Figure 11 shows the View menu as it appears on
your screen

Step 2. Notice that the list contains input, output.and
intermediate files. To view a file, select the item and
press <return>

Step 3. The file is now displayed on your screen. Notice
you can scroll up and down using the arrow keys.

Step 4. Press <esc> to exit the file.

26 Design a Decoder for the PALCE16V8 March 1989



Create the Decoder Design

Figure 11. View Menu

ime
Input data
Fuse map
JEDEC fuse data
JEDEC test data
Simulation history
Simulation trace

Other file

<enter> select an option <homestop of line 4 | «— move cursor <esc> exit

View the Compile Output Files
The compile process generates the following output files.

» The Fuse Map Decoder XPT

o The JEDEC Fuse Data  Decoder.JED
Notice the file names, shown above in italic, that PALASM assigns the

output files. The first part of the name is user-defined. The second part is
the extension that the software assigns.
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The Fuse Map

The fuse map is a detailed map of the connections that are programmed
along each product term on the device. The following symbols illustrate
which connections are programmed and unprogrammed.

X  Unprogrammed connection

— Programmed connection

The JEDEC Fuse Data

This file is the programmer-readable translation of the input design file. It
can be downloaded to the programmer to program the PALCE16V8.
JEDEC stands for Joint Electronic Device Engineering Council, the
organization that creates the standards for this file.

View the Simulation Output Files

The Simulation output files show you whether your design produces the
desired outputs. The Simulation process produces the following output
files.

» Simulation History Decoder HST
+ Simulation Trace Decoder. TRF
+ JEDEC Test Data Decoder JDC

The decoder design does not use the TRACE command. Therefore, the
trace file is not generated and is not discussed in this tutorial.
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The Simulation History

The simulation history shows the status-of all the signals defined in the pin
list. It uses symbols to represent the different states:

H High

L Low

X Undefined

Z Output disabled
Figure 12 shows a sample history file.

Figure 12. Sample Simulation History File

"g" represents "c" represents
SETF CLOCKF

g cg cg cg cg €g ¢cg cg C
CLOCK LHLLHLLHLLHLLHLLHLLHLLHL
LLLLLLLLLLLLLHHHHHHHHHHH
LLLLLLHHHHHHLLLLLLHHHHHH
LLLHHHLLLHHHLLLHHHLLLHHH
LLLLLLLLLLLLLLLLLLLLLLLL
HHHLLLLLLLLLLLLLLLLLLLLL
LLLHHHLLLLLLLLLLLLLLLLLL
LLLLLLHHHLLLLLLLLLLLLLLL
LLLLLLLLLHHHLLLLLLLLLLLL
LLLLLLLLLLLLHHHLLLLLLLLL
LILLLLLLLLLLLLLLHHHLLLLLL
LLLLLLLLLLLLLLLLLLHHHLLL
LLLLLLLLLLLLLLLLLLLLLHHH

T oM HOQwW Y g N
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The JEDEC Test Data

The simulation process generates test vectors that are added o the JEDEC
file discussed in The JEDEC File above. The test vectors can be used to test
and verify the design on the device programmer.

This completes the PALASM design and simulation process. The next step
is to download your JEDEC file to a device programmer. Consult the
Programmers Development Systems Table in this data sheet part of this
document for information on programmers. Also, refer to your
programmer manual for instructions on setup and use.

Where to Go from Here

This tutorial did not explore all the capabilities of PALASM software or the
PALCE16VS. To order the full-featured version of PALASM software,
contact your local AMD sales office today.
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